
Versione 0.82                      Preliminare

Da http://en.wikipedia.org/wiki/Software-defined_radio

"A software-defined radio (SDR) system is a radio communication system which uses 
software for the modulation and demodulation of radio signals."

CIAOradio  
(Computer Interface Audio Output radio)

Oscar Steila IK1XPV e Claudio Re I1RFQ
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Informazioni preliminari

Ambiente richiesto:

- Calcolatore di tipo Pentium III a 750Mhz o migliore,
- con sistema operativo Microsoft Windows 98SE, ME, NT, 2000, XP. 
- Nel caso si voglia utilizzare insieme a Dream per ricevere DRM è necessario un PentiumIV 
a 2Ghz o superiore.
- RAM minima di 256MB (512MB è consigliata).
- Scheda audio stereo che funzioni a16bit/48kHz per l'uscita audio, sistema di altoparlanti.
- Spazio libero sull' harddisk di almeno 1GB. (Lo spazio disponibile limita la quantità di 
registrazioni effettuabili ).
- CIAOradio ha un circuito di ingresso hardware dedicato chiamato H101

Installazione

L' installazione del programma è manuale:
- Realizzare un cartella dove desiderato (es esempio C:\Programmi\Cradio\)
- Copiare il contenuto del cdrom fornito 
- Copiare il file Registrazione.txt fornito.
- Si consiglia di realizzare un link su desktop a CIAOradio.exe 

Disinstallazione:

- Cancellare la cartella di CIAOradio ed il suo contenuto.
- CIAOradio non installa alcuna informazione all'interno del registro di sistema.

Questo manuale si riferisce alla versione del programma 1.23  connessa ad H101

Configurazione

-Installare il software presente nel CD

-Connettere H101 alla presa USB del computer.  Nel caso di prima installazione il sistema 
operativo riconosce automaticamente H101 (come USB speakers) e installa il driver 
necessario. (nel caso di Win98 può essere necessario il cd di installazione del sistema 
operativo).

-Lanciare CIAOradio.exe ( eventulamente creare un link sul desktop)

-CIAOradio presenta il dialogo di configurazione. Se questo non appare premere la voce del 
menu Setup->Configuration.
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Le voci presenti nel dialogo sono:

Sound in device: sceglie il dispositivo di ingresso, se H101 è presente scegliere il dispositivo 
USB, tipicamente chiamato USB speakers. E' un combobox, quindi occorre premere la 
freccia a destra per vedere le schede sound disponibili. Se H101 è installato occorre scegliere 
qui "USB Audio CODEC", su Win98 è chiamato "USB Speakers".

Sound device OUT 1: dispositivo 1 di uscita audio, tipicamente la scheda audio presente nel 
computer.

Sound device OUT 2: dispositivo 2 di uscita audio, uscita audio ausiliaria, nel caso si intenda 
impiegare Dream per ricevere DRM, o altro software che preveda l' ingresso da sound card è 
necessario installare  e qui selezionare VirtualCable. Si ricorda che VirtualCable è un 
dispositivo audio virtuale, se lo si utilizza come output non si sentirà nulla mentre il segnale 
verrà inviato ad  un altro programma, ad esempio Dream

Sound out control (USB H101) percorso di controllo di H101, se è  installata, deve 
coincidere con Sound in device.

ANT1/2 selection - questa lista permette di selezionare la generazione di comando per la 
commutazione tra due ingressi di antenna:

- NONE imposta nessuna commutazione
- COMn imposta una porta seriale asincrona (COM). In questo caso viene generato 

sulla porta seriale scelta un segnale di pilotaggio per un relay di commutazione di 
antenna esterna.

- CRH101 seleziona e aziona il sistema di commutazione di antenna interno di H101.

Center freq. Hz è la frequenza centrale del sistema di sintonia. Se non si usa H101 , serve ad 
impostare le frequenza centrale del display.
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TX mute è un check box che abilita il mute audio nel caso di segnali RF molto forti  . 
Questo per poter impiegare CIAOradio in coppia con un trasmettitore.

Aux Display contiene due bottoni che se selezionati visualizzano al posto della manopola di 
sintonia il display lineare nel tempo o di tipo xy dei segnali IQ di ingresso.
Nell'uso normale si consiglia di disattivarli. Possono servire per la messa a punto di un 
convertitore  I/Q esterno. Per completezza ecco le visualizzazioni che si abilitano al posto 
della manopola:

I&Q sampling correction permette la correzione di errori di guadagno hardware tra i due 
canali I&Q e la correzione di sfasamenti di qualche campione nel campionamento. Nel caso 
di H101 il default è delay 1, GAIN =1.0. Nel caso di sound card generiche impostare delay 0 
e gain 1.0

Sampling type La frequenza di sampling nel caso di H101 deve essere impostata a 48000 Hz, 
altri valori più bassi 44100,22050,11025 sono impiegabili nel caso si utilizzo con sound card 
diverse. I campioni sono sempre a 16bit e stereo.

CIAOradio H101 controller info (atinfo) ritorna un'informazione di identificazione del 
controller di H101.

Per accettare i cambiamenti premere <OK> altrimenti <Cancel>

Quando si chiude il dialogo CIAOradio configuration si (ri)attiva la finestra principale.

Nel caso di cambiamento dei dispositivi sound card, e anche durante la prima installazione di 
H101, può essere necessario chiudere il programma e quindi rilanciarlo perché i cambiamenti
abbiano effetto.
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Finestra Principale

Generalità

CIAOradio presenta nella parte superiore dello schermo la rappresentazione dello spettro di 
frequenza nell'intorno del segnale ricevuto : 48 kHz di banda che rappresentano la IF del 
nostro ricevitore.
Questo permette di selezionare i segnali  che si intendono ascoltare e di vedere eventuali 
segnali interferenti.
Nella parte in basso a sinistra è rappresentato in tempo reale lo spettro di frequenza del 
segnale demodulato, che coincide con la parte più scura dello schermo principale, vicino alla 
linea gialla che rappresenta la frequenza di sintonia.
In questa finestra è rappresentato con una lina verde anche il filtro di media frequenza . 
L’utilizzo del mouse permette la sua modifica in tempo reale.

A fianco in basso troviamo i bottoni che selezionano il modo ricevuto. Un led virtuale rosso 
acceso indica la selezione.

Al centro un indicatore Smeter permette di leggere il livello del segnale ricevuto.
Subito sotto altri bottoni permettono di controllare altri parametri del ricevitore. 

A destra abbiamo l'indicatore numerico della frequenza ricevuta espressa in Hz.
Un punto separa i MHz ed i KHz.
Ogni cifra ha due pulsanti che come un comando meccanico permettono di agire sulla cifra.
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La manopola di sintonia può essere bloccata con il mouse premendo il pulsante di sinistra e 
quindi ruotata in modo simile ad un ricevitore con sintonia meccanica.

In alto , un menù a tendine permette altri controlli.

Un primo utilizzo
Installato il software fornito e connessa H101 all'USB lanciamo CIAOradio.exe. Dopo aver 
predisposto la finestra di configurazione, descritta precedentemente, arriviamo alla finestra 
principale.

Se abbiamo già connesso un'antenna ad H101 possiamo iniziare ad impostare la frequenza 
che vogliamo ricevere, ad esempio 7.050.000.

La possiamo introdurre in molti modi diversi:

Utilizziamo il mouse e con  click sui pulsanti delle cifre componiamo la frequenza desiderata.

Con il mouse premiamo il pulsante <F> posto a destra del display della frequenza. Apparirà 
un tastierino in cui scrivere la frequenza, <Enter> lo chiude ed sintonizza la frequenza. Per 
sintonizzare è anche sufficiente premere il bottone <Tune>.

Possiamo utilizzare la manopola di sintonia per modificare la frequenza (lo step è impostato 
tramite la  barra del menù TS (Tuning Step)). Occorre bloccare la manopola tenendo premuto 
il pulsante sinistro del mouse e, sempre tenendolo premuto, ruotare la manopola. 

E' possibile modificare la sintonia anche con la rotella superiore (wheel) del mouse (se questo 
ne è dotato), lo step è lo stesso del caso precedente.

Se impostata la frequenza non vediamo segnali nello spettro possiamo verificare quale 
antenna è selezionata. Se il cavo è connesso ad esempio su Antenna 2 dobbiamo
premere il pulsante ANT 1 per fare apparire l'ingresso utilizzato (ANT 2), o viceversa.
Subito sotto possiamo imporre il guadagno IF a +20 o +40 dB e l'attenuazione ATT a 0.
A questo punto  cominciamo a vedere qualche segnale sullo spettro.

Impariamo ora un altro metodo di sintonia, possiamo infatti prendere con il mouse la linea 
gialla che rappresenta la sintonia e con un click sullo schermo la possiamo spostare in un 
altro punto (frequenza) sullo schermo, oppure trascinarla .

Il modo di demodulazione può essere scelto con un pulsante, ad esempio LSB o CW.
Notiamo ancora il controllo di volume a fianco della sintonia che controlla il livello si uscita. 
Se pur vedendo il segnale non ascoltiamo nulla, verificare nel Menu di configurazione che 
l'uscita prescelta (OUT1 o OUT2) sia la sound card di uscita dal computer e che l'eventuale 
volume esterno delle casse acustiche non sia a zero.
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Comandi
Nel seguito sono elencati i comandi presenti nella finestra principale.
Modi di demodulazione:

CW seleziona la ricezione nel modo CW. Il filtro 
di ricezione è largo circa 300 Hz, nell'intorno di 
850 Hz.
La banda osservate nella finestra del segnale 
demodulato viene impostata a 2 kHz. il CW è 
ricevuto in modo LSB (cioè la portante utilizzata 
per la demodulazione è
impostata più in alto del segnale di circa  850 Hz. 
Il filtro è modificable in tempo reale prendendo la 
sua immagine ( linea verde ) con il mouse ed il 
pulsante di sinistra e spostandola a piacere .
LSB seleziona la ricezione nel modo LSB. Il filtro 
di ricezione è impostato a 2.5kHz tra 250 e 2750 
Hz. La banda osservata nella finestra del segnale 
demodulato è impostata a 3 kHz. Il filtro è 
modificable in tempo reale prendendo la sua 
immagine con il mouse ed il pulsante di sinistra e 
spostandola a piacere .

USB seleziona la ricezione nel modo USB. Il fitro di ricezione è impostato a 2.5kHz tra 250 e 
2750 Hz. La banda osservata nella finestra del segnale demodulato è impostata a 3 kHz. 
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Ecco  un esempio di ricezione USB.

AM imposta la demodulazione di ampiezza. In questo caso il filtro IF estende tra -4kHz e 
+4kHz nell'intorno della sintonia (linea gialla). Il segnale demodulato è reppresentato su una 
banda di 8 KHz.
Nota: lo spettro del segnale demodulato si estende al di fuori del fitro IF. Questo perchè la 
demodulazione AM è un'operazione non lineare.

FM imposta la demodulazione di frequenza. In questo caso il filtro IF si estende tra -6kHz e 
+6kHz nell'intorno dell sintonia (linea gialla).  Il segnale demodulato è rappresentato su una 
banda di 12 kHz.

Nota: lo spettro del segnale demodulato si estende al di fuori del fitro IF. Questo perchè la 
demodulazione FM è un'operazione non lineare.

AMs inposta la demodulazione di frequenza di tipo sincrono. In questo caso il filtro IF 
estende tra -4 kHz e + 4 kHz nell'intorno della sintonia (linea gialla). Il segnale demodulato è
reppresentato su una banda di 8 KHz. La sintonia viene aiutata anche da un indicatore di 
centraggio che appare nella parte bassa dello Smeter.
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LBs imposta la demodulazione di frequenza di tipo sincrono. In questo caso il filtro IF 
estende tra -4 kHz e + 25 Hz nell'intorno della sintonia (linea gialla). Il segnale demodulato è
reppresentato su una banda di 8 KHz. La sintonia viene aiutata anche da un indicatore di 
centraggio che appare nella parte bassa dello Smeter.

UBs inposta la demodulazione di frequenza di tipo sincrono. In questo caso il filtro IF 
estende tra -25 Hz e + 4 kHz nell'intorno della sintonia (linea gialla). Il segnale demodulato è
reppresentato su una banda di 8 KHz. La sintonia viene aiutata anche da un indicatore di 
centraggio che appare nella parte bassa dello Smeter.

DRM in questo caso la sintonia è effettua con un filtro da -6kHz a+6KHz nell'intorno della 
sintonia. Questo segnale viene traslato a 10 kHz (o 12 kHz)  nella finestra del segnale 
demodulato ed inviato all'uscita. Se questa viene inviata al programma di ricezione DRM 
(Dream o DRM), tramite "Virtual Cable" (se installato, selezionare OUT 2) od il mixer di una 
sound card, si può demodulare un segnale DRM.

LPF una demodulazione USB con un filtro passa basso di 500 Hz. E' utilizzabile per misure 
di livello o demodulazione di segnali a banda stretta.

Controlli :

ANT1/2 permette di selezionare tra antenna 1 o 2. Attenzione che se nella configurazione è 
abilitata la commutazione automatica questo comando viene periodicamente modificato.

IF gain (-10,0,+20,+40 dB) permette di selezionare il guadagno della IF audio, normalmente 
impiegare +20 o +40. I valori più bassi servono nel caso di segnali molto forti in banda.
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ATT (0,-10,-20) permette di impostare un attenuatore di ingresso, normalmente è posto a 0.

IQ / AIQB abilita l'equalizzazione automatica del bilanciamento IQ.

OUT1/2 sceglie il dispositivo di uscita.

Vol è il controllo di volume a barra.

F attiva una tastiera per l'ingresso della frequenza.

R effettua l'arrotondamento della frequenza impostata allo step di sintonia programmato ad 
esempio se la frequenza sul display è 7.005.141 mentre lo step di sintonia 100 Hz, premendo 
R la sintonia diventa 7.000.100.

Come modificare il filtro IF.

Il filtro è rappresentato nella finestra del segnale demodulato da una linea verde. La linea 
rappresenta le reale risposta in frequenza del filtro e  può essere modificata prendendola con 
il mouse (click e tenere prenuto il pulsante sinistro), la linea diventa bianca e può essere 
spostata.

Se invece vogliamo introdurre un notch, come nella figura, dobbiamo portare il  cursore del 
mouse nella parte inferiore dello schermo, appena sopra la linea delle frequenza e tenendo 
premuto il pulsante destro, trascinarlo verso il basso per selezionare  la banda che si vuole 
eliminare. Se invece vogliamo chiudere il notch è sufficiente portare il mouse nella parte alta 
del filtro e tenendo premuto il pulsante destro, spostarlo per selezionare  la banda che si vuole 
inserire. E’ possibile inserire un numero a piacere di notch .
Occorre fare un poco di pratica . Alla fine il procedimento diventa naturale.
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Ecco Un esempio di come si può cancellare un segnale interferente molto forte tramite notch:

Barra del Menu

File

- Wave Player apre un dialog box che permette di ascoltare segnali registrati in precedenza 
come file,wav. 

Il pulsante <File>  apre una finestra che permette di selezionare il file.wav che si vuole 
riascoltare.
<PLAY> attiva l’ascolto e fa avanzare il cursore
<PAUSE> lo sospende e tiene fermo il cursore.
<STOP> lo interrompe e riporta il cursore all’inizio.
< >> > fa avanzare velocemente il segnale.
< << > fa tornare indietro velocemente il segnale.
Sulla sinistra la data della registrazione, sulla destra inizio, fine e ora del cursore.
Quando si ascolta un segnale registrato, il segnale di ingresso del ricevitore viene ignorato.
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• Start Wave I/Q Recording  inizia istantaneamente la registrazione dell'intera banda 
IF sintonizzata (24 o 48 kHz) per poi riascoltare in seguito con comodo la porzione di 
banda, ridemodulando a posteriori (anche mesi dopo) tutti i segnali presenti in questo 
arco di spettro come se si stesse ascoltando in diretta.

E’ presente il solo pulsante di <Stop> per spegnere la registrazione.
Queste registrazioni, in formato wav, richiedono una buona quantità di memoria libera 
sull'hard disk. In seguito i file interessanti possono essere archiviati su CD o DVD. Un dialog 
box viene aperto per ricordare il nome del file aperto in registrazione e ne permette 
successivamente la chiusura. 

• Start Audio Out Recording inizia a registrare immediatamente il segnale 
demodulato in un file in formato wav.  Un dialog box viene aperto per ricordare il 
nome del file aperto in registrazione e ne permette successivamente la chiusura.

- Exit chiude il programma.
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Tools

- Signal Level Trace apre una finestra che permette di visualizzare l'andamento nel tempo 
dell' ampiezza del segnale presente nel filtro di demodulazione.

- Waterfall apre una finestra che permette la visualizzazione dello spettro nella forma di 
spettrogramma (waterfall) in un'altra finestra.
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- Waterfall  Output apre una finestra che permette la visualizzazione dello spettro del solo 
segnale demodulato nella forma di spettrogramma (waterfall) in un'altra finestra.

- Reference Input produce un segnale sintetico all'ingresso composto da molte portanti 
virtuali di ampiezza diversa e cambiata nel tempo. E' stato utilizzato per lo sviluppo ed il test 
del programma e può essere impiegato per capire come funzionano alcuni comandi. Si 
spegne premendo OFF.

• Reference Ouput produce un segnale sintetico all' uscita composto da due portanti a 
1 e2 kHz di ampiezza uguale. E' utilizzabile  per verificare i settaggi di uscita  .

- Off spegne i segnali di riferimento.

Mode 

- I&Qstereo  è il modo di visualizzazione che permette la visione sullo schermo di 48kHz di 
banda (da -24kHz a +24kHz). Il picco che si vede al centro è il rumore nell'intorno della 
continua ed è generato della demodulazione diretta, come succede anche negli analizzatori di 
spettro.
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Notiamo che stiamo ricevendo un segnale in USB con portante a 8006 kHz.
La frequenza del segnale impiegata nel ricevitore eterodina è 8000 kHz. La frequenza 
intermedia audio  è a 6 kHz
La "frequenza centrale", intorno a cui si "articolano" i +24 kz e i meno 24 kHz della IF 
mostrata dalla finestra di spettro, è  nell'intorno di 8 MHz.
Il segnale nella modalità IQstereo  porta con se un aumento di rumore nell'intorno della 
frequenza centrale, é inevitabile, perché è il battimento zero. C’è anche in tutti gli 
analizzatori di spettro. Per escuderlo occorre andare nella modalita’ USB RX che 
semplicemente lo cancella, ma la banda visualizzata si riduce a  meno della metà.
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- Real viene visualizzata solo la parte speriore dell'intorno della continua da 0 a +24kHz
L'aumento di rumore della frequenza zero è visibile a sinistra .

- USBrx è simile al modo reale ma non visualizza l' intorno della continua a sinistra e la parte 
più alta dello spettro.
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Bwidth (Larghezza di banda)

- 1,....20 kHz  permette di selezionare la banda rappresentata nella finestra del segnale 
demodulato. Viene reimpostata anche selezionando il tipo di demodulazione.

AGC (Automatic Gain Control) La velocità è selezionabile tra:
- Normal
- Fast
- Slow
- Off disattiva l' AGC.

Notiamo che l’indicatore dello Smeter non utlizza l’AGC per misurare ma bensì calcola il 
valore rms nella banda passante del filtro di media, in modo molto veloce.
Il comportamento dell’AGC è visualizzato dalla barra rossa sulla sinistra della finestra 
demodulata.

NB (Noise Blanker)  Si consiglia di attivarlo solo in presenza di segnali impulsivi
- NB ON 
- NB OFF

TS (Tuning Step)
- 10Hz,... 1MHz  permette di cambiare lo step di sintonia  
utilizzata dalla rotella del mouse o dalla manopola dello 
schermo.

Setup
- Configuration apre la finestra di configurazione, descritta precedentemente

- Sound In apre il controllo di volume del sistema operativo in registrazione.  
Nel caso di H101 è normale avere il messaggio di errore:
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E' normale e dipende dal fatto che H101 non ha un miker di ingresso dovendo ricevere una 
sola sorgente audio. Ignorare il messaggio e premere OK.

- Sound Out apre il controllo di volume del sistema operativo in ascolto.
ATTENZIONE sotto la voce Optioni della finestra del controllo volume, si potranno 
selezionare controlli diversi per ognuna delle schede presenti nel sistema. Ad esempio nel 
caso di H101, Scheda audio interna, Virtual Cable i volumi di ascolto ecco alcune finestre:

Se premiamo proprietà possiamo scegliere la scheda audio e la funzione.

Ad esempio ecco il mixer di uscita USB e il suo settaggio corretto:
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Notiamo che l'ingresso USB di H101 non ha ingressi al mixer:
:

Nel caso di Virtualcable il suo settaggio originale è
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- Sys Info produce un rapporto con alcune informazioni sul computer (nella versione 123 non 
funziona la misura di velocità della CPU.)
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ReadMem.

   - Select memory Se premiamo questa voce, verrà visualizzato 
un menu di ricerca file per trovare il file desiderato ad esempio 
RAI_657_AMS.
-1,..20 Sono venti bottoni veloci che possono servire per 
appuntare le frequenza su cui in quel momento siamo interessati. 
Se la posizione è usata a fianco del numero appare la frequenza 
ed il modo di demodulazione.
I file vengono letti dal direttorio \radiomems\ costruito nel 
direttorio in cui risiede CIAORadio.

WriteMem.

      - Select memory Se premiamo questa voce, verrà 
visualizzato un menu per indicare il nome desiderato a 
file di memorizzazione esempio RAI_657_AMS. 
Notiamo che potranno essere creati direttori per 
ordinare i file per catagoria ad esempio Broadcast, OM, 
Marine...

-1,..20 sono venti tasti rapidi che permettono di 
appuntare la frequenza che in quel momento stiamo 
ascoltando, con la sola pressione della voce di menu.
I file vengono memorizzati nel direttorio \radiomems\ 
costruito nel direttorio in cui risiede CIAORadio.

Help

- Help questo file

- About
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Antenna
- Input 1 
- Input 2
E’ un duplicato del bottone ANT1 presente sotto lo Smeter. E’ stato inserito anche come 
dicitura del led virtuale presente subito sotto e che indica con colore blu e rosso quale delle 
due antenne è selezionata.
 
Smeter

Lo strumento segnala il livello ricevuto in S units oppure in DBr, le due scale sono 
commutate premendo il pulsante del mouse di sinistra sullo schermo Smeter.

Nel caso di demodulazione AM sincrona nella parte inferiore dello Smeter si presenta un 
indicatore di sintonia azzuro 

Overload
Se il segnale di ingresso è di livello elevato, ad esempio per un' antenna efficiente, ed il guadagno 
impostato troppo alto, il programma indica  la condizione di sovraccarico con la scritta 
overload come in figura:
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In questo caso è consigliato ridurre il guadagno IF a 20 dB oppure introdurre un'attenuatore 
all'ingresso ottenendo:
                                          

Misura di Antenne
CIAOradio permette di misurare in ricezione senza alcuna trasmissione il guadagno di 
antenne con il sistema del confronto.
Il programma misura il livello del segnale ricevuto impiegando un convertitore AD che 
permette una dinamica di 90 dB. Entro questa dinamica il programma misura il segnale 
demodulato con grande precisione. E' quindi possibile effetture misure di confronto tra due 
antenne commutate  tra loro, con uno schema generico del tipo:
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Se si usa H101 il commutatore di antenna è già integrato in H101. E' sufficiente collegare le 
due antenne ai due ingressi. Verificare commutando ANT1/ANT2 il loro funzionamento e 
quindi individuare un segnale su cui fare i confronti. Le emittenti broacasting sono un 
esempio, ma anche beacon e in genere qualunque segnale in banda.
Questo confronto può essere effettuato manualmente impiegando la commutazione ANT1/2 
ma è più comodo e oggettivo farlo automaticamente.

Per attivare questa funzone occorre aprire il dialogo configurazione e attivare il comando:

ANT1/2 selection - questa lista permette di selezionare la generazione di comando per la 
commutazione tra due ingressi di antenna:

- NONE imposta nessuna commutazione e funzionamento normale
- COMn imposta una porta seriale asincrona (COM). In questo caso viene generato 

sulla porta seriale scelta un segnale di pilotaggio per un relay di commutazione di 
antenna esterna.

 Si può usare un commutatore a relay e funziona anche senza H101, uno schema di 
attuatore può essere:

- CRH101 seleziona e aziona il sistema di commutazione di antenna interno di H101.

Per registrare il segnale occorre aprire la finestra Tools-> SignalTrace
Apparirà la finestra del tipo:
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Questa finestra riporta l'andamento dell'ampiezza del segnale in funzione del tempo.

La scala a sinistra può essere aggiustata per i nostri scopi muovendo con il mouse i pallini 
gialli sui valori estremi della zona di nostro interesse.

La barra verde a sinistra a cavallo della scala  indica il livello di segnale istantaneo.

La scala inferiore rappresenta il tempo e nel caso si utilizzino due antenne commutate è 
possibile notare il susseguirsi di antenna 1 (blu)  antenna 2 (rossa)
Nel caso si utilizzi un relay connesso ad una COM, i colori  possono essere diversi.

Guardiamo ora la linea del menu in alto, troviamo:

VideoBandWidth
Permette di introdurre un filtro passa banda sul segnale visualizzato. La larghezza del filtro 
può essere variata tra 30, 10, 3, 1 Hz. Per le misure con commutazione delle antenne è 
consigliabile 30 o 10 Hz.

Time Span
Seleziona la visualizzazione di 5, 15, 30 o 60 secondi sull'asse dei tempi. Non ha nessuna 
implicazione sulla misura, se non un impatto estetico.

Switch Rate
Seleziona la velocità di commutazione tra le antenne tra 0.13, 0.38,  1,  3, 10 secondi.
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Per la misura tra due antenne sono usabili solo 1,3,10 secondi. Infatti il tempo si 
commutazione tra le due antenne ha un transitorio nei filtri (compreso quello video) 
dell'ordine di 0.1 secondi.

Log Recording
in questa tendina del menu è possibile iniziare la registazione di un file di log delle ampiezze, 
o in alternativa terminare la stessa registrazione.

I file di log potranno successivamente essere esaminati con il programma CIAOlog.

CIAOlog
E' un programma impiegabile per una analisi dei file log registrati da CIAOradio.
Lanciato il programma avremo la finestra:

Per aprire il file di log usiamo la voce del menu File -> Open, apparirà un dialog che 
permette di selezionare il file desiderato.

Il file aperto verrà rappresentato in funzione del tempo.
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Il file visualizzato ha volutamente una grande differenza di livello tra i segnali acquisiti in 
tempi alterni su una o l'altra antenna. 
Per evidenziare le due antenne selezioniamo Mode -> Ant1 +Ant2 Measure

Nella stessa tendina possiamo scegliere  Single signal, Ant1 signal,  Ant2 signal ma in questi 
casi non è possibile fare la misura di confronto.
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Se invece del tempo vogliamo vedere la distribuzione statistica delle misure utilizziamo 
Tools->Statistics

In alto a destra abbiamo i risultati dell'analisi statistica dei dati e la differenza di guadagno tra 
le due antenne. 

Notiamo infine che è possibile usando il mouse selezionare le scale e l'intervallo di 
tempo di analisi
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Anche la statistica è calcolabile in questa sezione di dati

Notiamo che al diminuire delle misure il grafico diventa più granuloso e le misure 
diminuiscono di precisione.

H101dds

E' un programma per  utilizzare H101 come generatore DDS. E' possibile generare solo un 
segnale continuo (CW) non modulato tre 1Hz e 65 MHz.
H101dds.exe  non è usabile contemporaneamente a CIAOradio.exe
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Alcune domande frequenti

. Perché al centro dello spettro nel modo I/Q si nota un segnale anche senza antenna 
connessa?
E' la "frequenza centrale", intorno a cui si "articolano" i +24 kz e i meno 24 kHz della IF 
mostrata dalla finestra di spettro, ed è caratterizzata da un segnale di una certa intensità. 
Per ottenere il segnale nella modalità IQstereo é inevitabile, perché è il battimento zero. 
Esiste anche in tutti gli analizzatori di spettro. Per evitare di visualizzarlo occorre andare 
nella modalita’ USB RX che semplicemente lo cancella, ma la banda visualizzata si riduce a  
meno della metà. In generale è utile fare in modo che la frequenza di ascolto non coincida 
con quella "centrale" dello spectrum display. 

. Perché la frequenza di ascolto non è sempre al centro dello spettro?
La "frequenza centrale" è impostata ad un valore prossimo al desiderato, ma "modificata" per 
ridurre le spurie in banda del DDS (la dinamica del ricevitore è elevata). La posizione della 
sintonia sulla finestra permette di ottenere la frequenza desiderata.
La sintonia è ottenuta come frequenza centrale +  frequenza audio IF (può essere anche 
negativa, nel modo I/Q).

. Perché in alcuni casi il programma si puo’ bloccare?
Fisiologicamente , in ogni software esistono bachi che tendono a sparire  all’aumentare degli 
upgrades . 
Processare il segnale in tempo reale su sistemi operativi non proprio disegnati allo scopo, e’ 
un problema non di facile soluzione .

. Perché in alcune frequenze di H101 sono presenti segnali spuri.
Sono causati in alcuni casi da spurie del dds, Esistono inoltre disturbi causati dal rumore 
dell'USB nell'intorno di 12.0 Mhz e sue armoniche.

. Perché cambiando la costante di tempo dell'AGC lo Smeter continua a muoversi alla 
stesso modo.
Lo Smeter indica il livello di segnale rms nel filtro IF e non dipende dall'agc che agisce sul 
segnale demodulato,

. Perché se attivo il modo AIQB la cancellazione delle immagini dei segnali audio in 
banda, con riferimento alla continua, non sempre migliora.
Il sistema di bilanciamento si basa su calcoli statistici e non riesce a convergere se i segnali 
non sono correlati tra loro. 

 
.Perche' necessario impiegare Virtual Cable per ascoltare DRM o Dream.
Si utilizza VirtuelCable perchè permette di fornire a qualsivoglia programma di decodifica 
il segnale di uscita di CIAOradio come fosse una sound card reale.
In alternativa si può utilizzare il mixer di una scheda audio presente nel computer, per 
ri-acquisire il segnale generato in uscita, ma occorrono due sound cards.
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Altri programmi

Virtual Cable 
http://spider.nrcde.ru/music/software/eng/vac.html
" Virtual Audio Cable is a Windows WDM multimedia driver allowing you to transfer audio 
(wave) streams from one application to another. It creates a set of "Virtual Cables" each of 
them consists of a pair of the waveform input/output devices."
La versione demo 3.06 permette si realizzare un solo "virtual cable ",ed è sufficiente per l'uso 
con CIAOradio,  implementa infatti un solo canale audio virtuale.

Dream   http://sourceforge.net/projects/drm/
"Dream is a software implementation of a Digital Radio Mondiale (DRM) receiver. "
riferimenti in http://digital-radio-mondiale.wikiverse.org/

Note sui programmi.
CIAOradio.exe e CIAOlog.exe sono scritti utilizzando l'IDE Bloodshed DEV-CPP 
http:\\www,bloodshed.net

Il Manuale è stato scritto impiegando AbiWord, http:\\abisource.com

La  storia

CIAOradio  (Computer Interface Audio Output radio) nasce dal desiderio di Oscar Steila, 
IK1XPV e Claudio Re I1RFQ, di sperimentare queste nuove tecniche di ricezione nel 2004.
I colleghi radioamatori nell'utilizzare le prime versioni del programma hanno  contribuito a  
risolvere alcuni dei bachi presenti nel programma anche se altri sono ancora da risolvere.
Molte delle prestazioni del programma sono nate da suggerimenti di appassionati che hanno 
passato molto tempo con questa radio. Contiamo che l’aiuto continui.
Vogliamo ringraziare tutti, per le idee, la pazienza e la capacità di capire i nostri limiti, 
compreso quello di non saper ricordare tutte le persone che hanno contribuito . 
Tra le altre , in ordine casuale:

Michela e Mirtha,
Bill Miller, K4TYE,
Anselmo Stiffan, IZ3BGJ,
Jack Stone, http://www.antennex.com,
Il gruppo I-Link, http://www.i-link.it,
Giampiero Bernardini,  http://radiodxinfo.blogspot.com,
Angelo Brunero, I1QLD,
Andrea Borgnino, IW0HK
Pino Pastine, IK1DQG,
Rossano Sorrentino IK1NAO,
Paolo Romani,
Alberto Bernardelli ,
Andrea Negrini ,
Alessandro Santucci ,
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Roberto Magnani,
Rodolfo Zucchetti ,
Silvia Steila per la grafica
 ..e tutti gli altri..

Licenza

Nota:  il programma CIAOradio è fornito senza alcuna garanzia di alcun tipo. L'Utente accetta tutti i 
rischi che possono sorgere dall'impiego di questo software. L'uso del programma può causare o  
richiedere il reset del PC in caso di errore e potrebbe danneggiare dati  presenti nel computer.

Tutti i diritti sono riservati. La licenza consente l' utilizzo del programma è consentito per hobby ed 
utilizzo personale. Ogni utilizzo commerciale è espressamente proibito senza un consenso scritto. Non 
è consentito cercare di  de-compilare, modificare, tradurre or disassemblare il software nella totalita’ 
od in parte .
Il programma CIAOradio è fornito senza alcuna garanzia. Gli autori non dichiarano alcuna particolare 
abilità o prestazione del programma.  Gli Utenti accettano tutti i rischi che possono derivare da questo 
programma. L'utilizzo dell'edizione completa richiede la registrazione .

Attenzione

CIAOradio è un programma che processa il segnale audio ricevuto in tempo reale.
A causa di eventuali problemi di funzionamento CIAOradio può bloccare il PC ospite, 
causare un reset e quindi dati presenti sul computer ed al momento non salvati 
potrebbero andare perduti . 
Si consiglia di fare un backup dei dati prima di installare ed utilizzare CIAOradio.
Durante il funzionamento CIAOradio si può bloccare e richiedere lo spegnimento del 
computer.

ATTENZIONE: il radioascolto è regolamentato da leggi che possono cambiare da paese 
a paese. Per conoscerle e rispettarle si consiglia di rivolgersi alle associazioni locali di 
radio ascolto.
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